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1 Major Safety Precautions

1-1 Before You Start

Icons used in this manual

Using this Manual
• The contents of this manual are subject to change without prior notice for performance improvement.

• Make yourself fully aware of the safety precautions before using this product.

• If a problem occurs, refer to the 'Troubleshooting' section.

License

Open source license notice
In the case of using open source software, Open Source License are available on the product menu. 

 

ICON NAME MEANING

Caution Indicates cases where the function may not work or the setting may be canceled.

Note Indicates a hint or tip to operate a function.

Manufactured under license from Dolby Laboratories.

Dolby and the double-D symbol are trademarks of Dolby Laboratories.

DivX Certified to play DivX video up to HD 1080p, including premium content.

ABOUT DIVX VIDEO: DivX® is a digital video format created by DivX,Inc. 

This is an official DivX Certified device that plays DivX video.

Visit www.divx.com for more information and software tools to convert your files into DivX video.

ABOUT DIVX VIDEO-ON-DEMAND: This DivX Certified® device must be registered in order to 
play DivX Video-on-Demand (VOD) content. 

To generate the registration code, locate the DivX VOD section in the device setup menu.

Go to vod.divx.com with this code to complete the registration process and learn more about 
DivX VOD.

Pat. 7,295,673; 7,460,688; 7,519,274

Manufactured under license under U.S. Patent #’s: 5,451,942; 5,956,674; 5,974,380; 
5,978,762; 6,487,535 & other U.S. and worldwide patents issued & pending. 

DTS and the Symbol are registered trademarks, & DTS 2.0+ Digital Out and the DTS logos are 
trademarks of DTS, Inc. Product includes software. ©DTS, Inc. All Rights Reserved.

TheaterSound, SRS and the  symbol are trademarks of SRS Labs, Inc.

TheaterSound technology is incorporated under license from SRS Labs, Inc.
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Copyright Notice
Copyright © 2010 Samsung Electronics Co., Ltd. All Rights Reserved.

The copyright of this manual is reserved by Samsung Electronics, Co., Ltd.

The contents of this manual may not be partially or in whole reproduced, distributed or used in any form without the written 
permission of Samsung Electronics, Co., Ltd.

The SAMSUNG logo and SyncMaster are the registered trademarks of Samsung Electronics, Co., Ltd.

Microsoft, Windows and Windows NT are the registered trademarks of Microsoft Corporation.

VESA, DPM and DDC are the registered trademarks of the Video Electronics Standard Association.

All other trademarks mentioned herein belong to their respective companies.
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1-2 Care and Maintenance 

External Surface and Screen Maintenance

Securing the Installation Space
• Keep the required distances between the product and other objects (e.g. walls) to ensure proper ventilation.

Failing to do so may result in fire or a problem with the product due to an increase in the internal temperature of the product.
 

When using a stand or wall-mount, use parts provided by Samsung Electronics only.
 

• If you use parts provided by another manufacturer, it may result in a problem with the product or an injury due to the 
product falling.

 

The appearance may differ depending on the product.
 

About persistent images
• Displaying a still image for a long time may create a persistent image or stain on the screen. 

If you do not use the product for a long time, set the power-saving mode or screen saver.

• Due to technological constraints of the Panel manufacturer, the images generated by this product may appear either brighter 
or darker than normal by appr. 1ppm (parts per million) pixel.
The number of sub-pixels of an panel by size:  The number of Sub-Pixels = Max. Horizontal Resolution x Max. Vertical 
Resolution x 3
Example) If the maximum resolution is 1920 x 1080, the number of sub-pixels is 1920 x 1080 x 3 = 6,220,800.

Clean the product with a soft dry cloth.

• Avoid cleaning the product with an inflammable substance such 
as benzene or thinner or with a wet cloth. This may result in a 
problem with the product.

• Avoid scratching the screen with your fingernails or a sharp 
object.

• Avoid cleaning the product by spraying water onto it. If water 
enters the product, it may result in fire, electric shock or a 
problem with the product.

• A white stain may be generated on the surface of the model if a 
supersonic humidifier is used near it.

 

The appearance and the color may differ depending on models.
 

When installing the product with a stand When installing the product with a wall-mount
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1-3 Safety Precautions

Icons used for safety precautions

Meaning of Signs

Power Related
 

The product image used in the following pictures for your reference may look different from the actual product.
 

Warning

ICON NAME MEANING

Warning
Failing to follow the precautions marked with this sign may result in a serious injury or even a 
fatality.

Caution
Failing to follow the precautions marked with this sign may result in a personal injury or property 
damage.

Do not perform. Must be followed.

Do not disassemble.
The power plug must be unplugged from the 
wall outlet.

Do not touch. Must be grounded to prevent electric shock. 

Avoid using a damaged power cord or plug 
or a loose power outlet.

• Otherwise, it may result in electric shock 
or fire.

Avoid connecting multiple electric appli-
ances to a single wall outlet.

• Otherwise, it may result in fire due to 
overheating of the wall outlet.

Avoid plugging in or unplugging the power 
supply with wet hands.

• Otherwise, it may result in electric 
shock.

Plug the power plug in firmly.

• Otherwise, it may result in fire.

Make sure to connect the power cord to a 
grounded wall outlet (for insulation class 1 
equipment only).

• Otherwise, it may result in electric shock 
or injury.

Avoid bending or twisting the power cord 
excessively and avoid placing heavy objects 
on the cord.

• Otherwise, it may result in electric shock 
or fire due to a damaged power cord.

Keep the power cord and the product away 
from a heater.

• Otherwise, it may result in electric shock 
or fire.

If the pins of the power plug or the wall out-
let are covered in dust, clean it using a dry 
cloth.

• Otherwise, it may result in fire.
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 Caution

Installation Related 

Warning

Avoid unplugging the power plug while the 
product is operating.

• Otherwise, it may damage the product 
due to electric shock.

Make sure to use only the power cord sup-
plied by our company. In addition, do not 
use the power cord of another electric appli-
ance. 

• Otherwise, it may result in electric shock 
or fire. 

When unplugging the power plug from the 
wall outlet, make sure to hold it by the plug 
and not by the cord. 

• Otherwise, it may result in electric shock 
or fire. 

Connect the power plug to a wall outlet that 
can be easily reached.

• When a problem occurs with the 
product, you must unplug the power 
plug to cut the power off completely. You 
cannot cut the power off completely 
using only the power button on the 
product. 

Avoid placing burning candles, mosquito-
repellent or cigarettes on the product.

• Otherwise, it may result in fire.

Ask an installation engineer or relevant 
company to install the product onto the wall.

• Otherwise, it may result in injury. 

• Make sure to use the specified wall 
mount.

Avoid installing the product in a badly-venti-
lated location such as inside a bookshelf or 
closet.

• Otherwise, it may result in fire due to 
internal over-heating.

Keep a distance of at least 10 cm(3.93 
inches) from the wall when installing the 
product for ventilation.

• Otherwise, it may result in fire due to 
internal over-heating.

Keep the plastic bags used to pack the 
product away from children.

• If children place the plastic bags over 
their heads, they may suffocate.

Avoid installing the product in a location that 
is unstable or exposed to excessive vibra-
tions such as on an unstable or slanted 
shelf.

• The product may fall and this may result 
in damage to the product or injury.

• If you use the product in a location 
exposed to excessive vibration, it may 
result in a problem with the product or 
fire.

Avoid installing the product in a location 
exposed to dust, moisture (sauna), oil, 
smoke or water (rain drops) and installing it 
within a vehicle. 

• This may result in electric shock or fire.

Avoid installing the product in a location 
exposed to direct sunlight and installing the 
product near a heat source such as a fire-
place or heater.

• This may shorten the product life cycle 
or cause fire.
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 Caution

Cleaning Related

Warning

Avoid installing the product where children 
may reach it.

• If a child touches the product, the 
product may fall and this may result in 
injury. 

• Since the front part is heavier, install the 
product on a flat and stable surface. 

Bend the outdoor antenna cable downwards 
at the location where it comes in the house 
so that rainwater does not flow in.

• If rainwater enters the product, it may 
result in electric shock or fire.

Install the antenna far away from any high 
voltage cables.

• If the antenna touches or falls onto a 
high voltage cable, it may result in 
electric shock or fire.

Do not let the product drop while moving it. 

• This may result in a problem with the 
product or injury. 

Do not place the product face down on the 
floor.

• This may damage the panel of the 
product.

When installing the product on a console or 
shelf, make sure that the front of the product 
does not protrude out of the console or 
shelf.

• Otherwise, this may cause the product 
to fall off and result in a malfunction or 
injury.

• Make sure to use a cabinet or shelf 
suitable to the size of the product.

When putting the product down, handle it 
gently. 

• Otherwise, it may result in a problem 
with the product or injury. 

If the product is installed in a location where 
the operating conditions vary considerably, 
a serious quality problem may occur due to 
the surrounding environment. In this case, 
install the product only after consulting one 
of our service engineers about the matter.

• Places exposed to microscopic dust, 
chemicals, too high or low temperature, 
high humidity, airports or stations where 
the product is continuously used.

Before cleaning the product, unplug the 
power cord.

• Otherwise, it may result in electric shock 
or fire.

When cleaning the product, do not spray 
water directly over the product parts. 

• Make sure that water does not enter the 
product. 

• Otherwise, it may result in fire, electric 
shock or a problem with the product. 
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 Caution

Usage Related

 Warning

Avoid spraying cleansing agent directly onto 
the product.

• This may result in discoloration or 
cracking of the exterior of the product or 
the panel coming off.

When cleaning the product, disconnect the 
power cord and clean the product with the 
supplied cleaning cloth.

• Avoid using chemicals such as wax, 
benzene, alcohol, thinner, mosquito-
repellent, fragrance, lubrication or 
cleansing agent when cleaning the 
product.
This may result in the exterior being 
deformed or the print being removed.

If you can't get the product clean with just 
the supplied cloth, use a soft, damp cloth 
with a "monitor-exclusive cleansing agent" 
and wipe the product with it.

• If no monitor-exclusive cleansing agent 
is available, dilute a cleansing agent 
with water at a ratio of 1:10 before 
cleaning the product.

Since the exterior of the product is easily 
scratched, be sure to use the supplied 
cleansing cloth.

Since a high voltage runs through the prod-
uct, never disassemble, repair or modify the 
product yourself.

• Otherwise, it may result in fire or electric 
shock.

• If the product needs to be fixed, contact 
a service center.

To move the product, turn the power off and 
unplug the power cord, the antenna cable 
and any other wires connected to the prod-
uct.

• Otherwise, it may result in electric shock 
or fire due to the damaged power cord.

If the product generates a strange noise, a 
burning smell, or smoke, unplug the power 
plug immediately and contact a service cen-
ter.

• Otherwise, it may result in electric shock 
or fire. 

Avoid letting children hang or climb onto the 
product.

• Otherwise, it may result in the product 
falling and this may result in injury or 
death.

If you drop the product or the case is dam-
aged, turn the power off and unplug the 
power cord. Contact a Service Center.

• Otherwise, it may result in fire or electric 
shock.

Avoid placing objects such as toys and 
cookies on top of the product.

• If a child hangs over the product to grab 
an object, the object or the product may 
fall and this may result in injury or even 
death.

When thunder or lighting occurs, unplug the 
power cord and under no circumstance 
touch the antenna cable as this is danger-
ous.

• Otherwise, it may result in electric shock 
or fire.

Avoid dropping an object over the product 
or cause impact to the product.

• Otherwise, it may result in electric shock 
or fire.
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 Caution

Avoid moving the product by pulling the 
power cord or antenna cable.

• Otherwise, it may result in electric 
shock, fire or a problem with the product 
due to damage to the cable.

When a gas leak occurs, do not touch the 
product or the power plug and ventilate 
immediately.

• A spark may result in an explosion or 
fire.

• During a thunder or lighting storm, do 
not touch the power cord or antenna 
cable.

Avoid lifting up or moving the product by 
holding only the power cord or signal cable.

• Otherwise, it may result in electric 
shock, fire or a problem with the product 
due to damage to the cable.

Avoid using or placing inflammable spray or 
objects near the product.

• This may result in an explosion or fire.

Take care not to block the vent by a table 
cloth or curtain.

• Otherwise, it may result in fire due to 
internal overheating.

Avoid inserting metal objects such as a 
chopsticks, coins or hairpins, or inflamma-
ble objects into the product (the vents, 
ports, etc).

• If water or substances enter the product, 
turn the power off, unplug the power 
cord and contact a service center.

• Otherwise, it may result in a problem 
with the product, electric shock or fire.

Avoid placing a liquid container such as a 
vase, flowerpot, beverage, cosmetics or 
drugs, or a metal object over the product.

• If water or substances enter the product, 
turn the power off, unplug the power 
cord and contact a service center.

• Otherwise, it may result in a problem 
with the product, electric shock or fire.

Displaying a still image for a long time may 
create a persistent image or stain on the 
screen.

• If you do not use the product for a long 
time, use the power-saving mode or set 
the screensaver to the moving picture 
mode.

When not using the product for a long time 
such as leaving your home, unplug the 
power cord from the wall outlet.

• Otherwise, it may cause dust 
accumulation and result in fire caused 
by overheating or short circuit or result in 
an electric shock.

Set the appropriate resolution and fre-
quency for the product.

• Otherwise, it may result in eye strain.

Avoid turning the product upside down or 
move the product holding only the stand.

• This may cause the product to fall, 
resulting in damage to the product or 
injury.

Do not place the adapter on top of another 
adapter.

• Otherwise, it may result in fire.

Keep power adaptor away from any other heat 
source. 

• Otherwise, it may result in fire.

Remove the vinyl cover of the adapter before 
using the adaptor.

• Otherwise, it may result in fire.

Always keep power adaptor in well-venti-
lated area. 
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Be careful that adaptor should not be in contact 
with water and therefore not be wet. 

• This may cause a malfunction, electric 
shock or fire. Do not use adaptor by the 
waterside or outside particularly when it 
rains or snows. Be careful that adaptor 
should not be wet while cleaning floor with 
water.

Watching the product from too close a dis-
tance continuously may damage your eye-
sight.

Avoid using a humidifier or cooker near the 
product.

• Otherwise, it may result in electric shock 
or fire.

It is important to give your eyes some rest (5 
minutes every hour) when viewing the prod-
uct screen for long periods of time.

•  This will alleviate any eye strain.

Since the display panel is hot after using it 
for a long time, do not touch the product.

Keep the small accessories in a location out 
of the reach of children.

Take care when adjusting the angle of the 
product or the height of the stand.

• If your hand or finger is caught, you may 
be injured.

• If the product is tilted excessively, the 
product may fall and this may result in 
injury.

Avoid placing a heavy object over the prod-
uct.

• Otherwise, it may result in a problem 
with the product or injury.

When using headphones or earphones, do 
not turn the volume too high.

• Having the sound too loud may damage 
your hearing.

Be careful that children do not place the bat-
teries in their mouths when removed from 
the remote control. Place the battery in a 
location that children or infants cannot 
reach.

• If children have had the battery in their 
mouths, consult your doctor 
immediately.

When replacing the batteries, insert them 
with right polarity (+, -).

• Otherwise, the battery may become 
damaged or it may cause fire, personal 
injury or damage due to leakage of the 
internal liquid.

Use only specified standard batteries. Do 
not use new and used batteries together.

• This may cause a battery to break or 
leak and may cause fire, injury, or 
contamination (damage). 

The batteries (and rechargeable batteries) 
are not ordinary refuse and must be 
returned for recycling purposes. The cus-
tomer is responsible for returning the used 
or rechargeable batteries for recycling.

• The customer can return used or 
rechargeable batteries to a nearby 
public recycling center or to a store 
selling the same type of the battery or 
rechargeable battery. 
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Maintaining the Correct Posture when Using this Product

Maintain the correct posture when using this product.

• Straighten your back.

• Keep a distance of 45~50 cm (18~19 inches) from your eyes to the screen. Look down at 
the screen and face the screen forwards.

• Adjust the angle of the product so that light is not reflected onto the screen.

• Keep your elbow at a right angle and keep your arm level with the back of your hand.

• Keep your elbow at a right angle.

• Place your heels flat on the ground while keeping your knees at an angle of 90 degrees or 
higher and maintain the position of your arm so that your arm is below your heart.
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2 Installing the Product

2-1 Package Contents

 

• Unpack the product and check if all of the following contents have been included.

• Store the packaging box in case you need to move the product at a later stage.

• If any items are missing, contact your dealer. 

• Contact a local dealer to purchase optional items.
 

 

• The color and the appearance may differ depending on the product, and the specifications are subject to change without 
prior notice to improve the performance. 

• The cleaning cloth is supplied with black high-glossy models only.
 

CONTENTS

Quick Setup Guide Warranty Card

(Not available in all locations)

User Manual Remote Control & 

Batteries (AAA X 2) 

Cable Holder Stand & Screw (2EA) Power Cord DC-Adapter

Cleaning Cloth Stereo Cable D-Sub Cable

SOLD SEPARATELY

HDMI Cable HDMI to DVI cable
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2-2 Installing the Stand

 

Before assembling the product, place the product down on a flat and stable surface so that the screen is facing downwards.
 

 

The color and the appearance may differ depending on the product, and the specifications are subject to change without 
prior notice to improve the performance.

 

Place a soft cloth over the table to protect the product and place the product onto the 
cloth face down.

Insert the stand base into the stand as shown in the figure.

Firmly fasten the stand using the screws.

- Caution

Do not lift the product by only its stand.
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2-3 Removing the Stand

 

Before removing the stand, place the product down on a flat and stable surface so that the screen faces downwards.
 

 

The color and the appearance may differ depending on the product, and the specifications are subject to change without 
prior notice to improve the performance.

 

Place a soft cloth over the table to protect the product and place the product face down.

Remove the screws from the bottom of the stand.

Pull the stand from the stand base to remove.

Before you attach the bracket, unfasten the screw and remove the stand base.

The stand base is now removed.
 

• The Wall mount of this model is only supported as WMN-2490.

• The wall mount kit is not supplied, but sold separately.

•     If you want to purchase this Wall Mount, contact an authorized dealer. 
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2-4 Connecting to a Computer

 

The connecting part may differ depending on the product model.
 

1. Connect the product to a PC depending on the video output supported by the PC.

When the graphics card provides a D-Sub (<analog>) output

• Connect the [PC IN] port of the product to the D-Sub port of the PC with the D-Sub cable. 

When the graphics card provides a DVI (<digital>) output

• Connect the [HDMI (DVI) IN] port of the product to the DVI port of the PC with the HDMI to DVI cable.

When the graphics card provides a HDMI output

• Connect the [HDMI (DVI) IN] port of the product to the HDMI port of the PC with the HDMI cable.
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When a PC with a resolution of 1920 x 1080 @ 60 Hz is connected to the [HDMI (DVI) IN] port, you should set the <HDMI> 
mode to <DVI PC> in the <Edit Name> of the <Input> mode. In this case, a separate sound connection is required. 

 

2. Connect the [PC/DVI AUDIO IN] port on the rear side of the product to the sound card of the PC.

3. Connect the power adapter to [DC14V] on the rear of the product. Connect the power cord to the adapter and wall socket.

(The input voltage is switched automatically.)
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• You may enjoy clear and quality sound from the computer sound card using the product's speakers. (You don't need to 
install separate speakers for your computer.)
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2-5 Using it as a TV

You may view television programs on the product if it is connected to an antenna or cable system without installing any separate 
TV reception hardware or software on your computer.

1. Connect the cable or TV antenna cable to the [ANT IN] port on the rear side of the product. 

• When using an indoor antenna/cable terminal:
Check the antenna terminal on the wall and then connect the antenna/cable/satellite TV cable.

• When using an outdoor antenna:
When using an outdoor antenna, we strongly suggest using a qualified technician to install it.

2. When the connections are completed, connect the TV power.

3. When the product is turned on for the first time after it was purchased, the initial setup operations <Plug&Play> begin. 
 

Be careful that the coaxial cable is not bent when connecting it to the antenna input terminal [ANT IN].

Standby mode
Do not leave your TV in standby mode for long periods of time (when you are away on a holiday, for example). A small 
amount of electric power is still consumed even when the power button is turned off. It is best to unplug the power cord.
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2-6 Connecting an HDMI cable

1. Connect the HDMI OUT port of the AV device (Blu-ray/DVD/Cable/Satellite box) to the [HDMI (DVI) IN] terminal of the product 
using the HDMI cable. 

2. Press the [SOURCE] button at the front of the product or on the remote control to select <HDMI> mode.

 

You do not need to make a separate audio connection when connecting via HDMI.
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2-7 Connecting Using a DVI to HDMI Cable 

1. Connect the DVI output terminal of an external device to the [HDMI (DVI) IN] terminal of the product using a DVI to HDMI 
cable.

2. Connect the red and white plugs of an RCA to stereo (for PC) cable to the same colored audio output terminals of the digital 
output device, and connect the opposite plug to the [PC/DVI AUDIO IN] terminal of the product.

Press the [SOURCE] button at the front of the product or on the remote control to select <HDMI> mode.
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2-8 Connecting a Component cable 

1. Connect the VIDEO OUT port of the AV device (DVD/VCR/Cable/Satellite box) to the [COMPONENT IN / AV IN] input ports 
using a component video cable [PR, PB,Y].

2. Connect the audio port of the AV device (DVD/VCR/Cable/Satellite box) to the [AUDIO (R-AUDIO-L)] port of the product.

Press the [SOURCE] button at the front of the product or on the remote control to select the <Component> mode.

 

For an explanation of Component video, consult your DVD/VCR/Cable/Satellite box manual.
 

2-8 Installing the Product



2-9 Connecting AV Devices

1. Connect the port of the AV device (DVD/VCR/Cable/Satellite box/Camcorder) to the [AUDIO IN (R-AUDIO-L)] port of the 
product.

2. Connect the video output terminal of the AV device and the [COMPONENT IN / AV IN] of the product using a video cable.

3. Select <AV> using the [SOURCE] button on the remote.

 

The audio-video cables shown here are usually included with a Camcorder. (If not, check your local electronics store.)
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2-10 Connecting to an Amplifier

Connect the [DIGITAL AUDIO OUT (OPTICAL)] terminal of your product to the optical input of your amplifier using an optical 
cable.

 

• If no sound is emitted from the product, you need to use an amplifier.

• For information on how to connect a speaker and amplifier, refer to the respective user manuals provided by their 
manufacturers.
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EX-LINK: Connector for service only.

 

2-11 Connecting Headphones 

Connect your headphones to the Headphone connection terminal.
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2-12 Kensington Lock 

A Kensington Lock is an anti-theft device that enables users to lock the product so that they can safely use it in public locations. 
Since the shape and usage of the locking device may differ depending on the model and the manufacturer, refer to the User 
Manual supplied with the locking device for more information. 
 

You must purchase the Kensington Lock separately.
 

To lock the product, follow these steps:
1. Wrap the Kensington lock cable around a large, stationary object such as a desk or chair.

2. Slide the end of the cable with the lock attached through the looped end of the Kensington lock cable.

3. Insert the locking device into the Kensington slot on the product ( ) .

4. Lock the lock ( ).
 

• These are general instructions. For exact instructions, see the User Manual supplied with the locking device.

• You can purchase the locking device from an electronics store, an online shop, or our service center.
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3 Using the Product

3-1 Plug & Play Feature

When the TV is initially powered on, basic settings proceed automatically and subsequently.
 

To return to the previous step, press the Red button.
 

1. Press the [POWER ] button on the remote control.
 

• You can also use the [ ] button on the TV.

• The message <Select Language of the OSD.> is displayed. 
 

2. Press the [ ] button. Select the appropriate language by pressing the ▲ or ▼ button. Press the [ ] button to confirm your 
choice. 

3. Press the ◄ or ► button to select <Store Demo> or <Home Use>, then the [ ] button. 
 

• We recommend setting the TV to <Home Use> mode for the best picture in your home environment.

• <Store Demo> mode is only intended for use in retail environments. If the unit is accidentally set to <Store Demo> 
mode and you want to return to <Home Use> (Standard): Press the volume button on the TV. When the volume 
OSD is displayed, press and hold the [ MENU ] button on the TV for 5 seconds.

 

4. Press the [ ] button. Press the ▲ or ▼ button to select <Air>, <Cable> or <Auto>, then press the [ ] button.
 

• <Air>: <Air> antenna signal. / <Cable>: <Cable> antenna signal. 

• In Cable mode, you can select the correct signal source among <STD>, <HRC>, and <IRC> by pressing the ▲, ▼, 
◄ or ► button, then press the [ ] button. If you have Digital cable, select the cable system signal source for both 
Analog and Digital. Contact your local cable company to identify the type of cable system that exists in your 
particular area.

 

5. Press the ▼ button to select <Search>, then press the [ ] button.
 

• To stop the search before it has finished, press the [ ] button with <Stop> selected.

• After all the available channels are stored, it starts to remove scrambled channels. The Auto program menu then 
reappears. Press the [ ] button when channel memorization is complete. The message <Set the Clock Mode.> is 
displayed.

 

6. Press the [ ] button.

Press the ▲ or ▼ button to select <Auto>, then press the [ ] button. The message <Set to daylight saving time.> is 
displayed. If you select <Manual>, <Set current date and time> is displayed.

7. Press the ▲ or ▼ button to select <Off>, <On>, then press the [ ] button.

8. Press the ▲ or ▼ button to highlight the time zone for your local area. 

Press the [ ] button. If you have received a digital signal, the time will be set automatically.

9. The connection method to provide the best quality HD is offered. After confirming the method, press the [ ] button.
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10. The message <Enjoy your TV.> is displayed. When you have finished, press the [ ] button.

If you want to reset this feature...

1. Press the [MENU] button to display the menu. Press the ▲ or ▼ button to select <Setup>, then press the [ ] button.

2. Press the [ ] button again to select <Plug & Play>.
 

The <Plug & Play> feature is only available in the <TV> mode.
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3-2 Viewing the Control panel

ICON DESCRIPTION

Speakers -

[SOURCE ] Toggles between all the available input sources. In the on-screen menu, use this but-
ton as you would use the [ ] button on the remote control. 

[MENU] Press this button to view the On Screen Display (OSD).

This button is also used to exit the OSD or to return to a higher-level OSD menu.

[ ] Moves from one menu item to another horizontally or adjusts selected menu values.

Adjusts the audio volume. 

[ CH ] Use these buttons to navigate the menu or to adjust a value in the OSD.

Press to change channels in TV mode.

[ ] Press this button to turn the product on or off. 

Remote control sensor Aim the remote control towards this spot on the TV.

Power Indicator -
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3-3 Remote Control

 

The performance of the remote control may be affected by a TV or other electronic device operating near the product, 
causing a malfunction due to interference with the frequency.

 

POWER ( ) button
Turns the product On/Off.

SOURCE( ) button
Press the button to change the 
input signal SOURCE.

Number Buttons
Press to change the channel.

PRE-CH button
This button is used to return to 
the immediately previous chan-
nel.

(-) button
Press to select additional chan-
nels(digital) being broadcast by the 
same station. For example, to select 
channel '54-3', press '54', then 
press ‘-’ and '3'.

MUTE ( ) button
Press to temporarily cut off the 
sound.

- VOL+ button
Press to increase or decrease the 
volume.

CH  button
Press to change channels.

MEDIA.P button
Displays <Media Play>

CH.LIST button
Displays the channel list on the 
screen.

MENU ( ) button
Opens the on-screen menu and 
exits from the menu or closes the 
adjustment menu.

FAV.CH button
Press to switch to your favorite 
channels.

TOOLS ( ) button
Use to quickly select frequently 
used functions.

INFO ( ) button
Current picture information is dis-
played on the upper left corner of 
the screen.

Move (▲▼◄►) / ( ) buttons 
Use to select on-screen menu items 
and change menu values.

EXIT ( ) button
Exits from the menu screen.

RETURN ( ) button
Returns to the previous menu.

MTS button
Press to choose stereo, mono or 
Separate Audio Program (SAP 
broadcast).

Color buttons
Buttons used in the <Channel List>, 
<Media Play> menu, etc.

CC button
Controls the caption decoder.

S.MODE button
Press to select the sound mode.

P.SIZE button
Picture size selection.

SLEEP button
Automatically shuts off the TV.

Controls button
Use these buttons in <Media 
Play> and <Anynet+> modes.

(  : Controls recording for Sam-
sung recorders that have the 
Anynet+ feature)

P.MODE button
Selects picture mode.
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Installing Batteries in the Remote Control 
1. Lift the cover at the back of the remote control upward as shown in the figure.

2. Install two AAA size batteries.
 

Make sure to match the +and - ends of the batteries with the diagram inside the compartment.
 

3. Close the cover.
 

Remove the batteries and store them in a cool, dry place if you won‘t be using the remote control for a long time.

If the remote control doesn‘t work, check the following :

• Is the TV power on?

• Are the plus and minus ends of the batteries reversed?

• Are the batteries drained?

• Is there a power outage or is the power cord unplugged?

• Is there a special fluorescent light or neon sign nearby?
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3-4 Using the Screen Adjustment Menu (OSD: On Screen Display)

The Screen Adjustment Menu (OSD: On Screen Display) Structure

Picture [PC / HDMI PC Timing]

 The default setting may be different depending on the selected Input Mode (input signal source selected in External Input 
List) and the selected resolution.

 

TOP MENUS SUB MENUS

Picture

[PC / HDMI PC Timing]

MagicBright MagicAngle Contrast Brightness Sharpness

Eco Solution Auto Adjustment Screen Picture Options Picture Reset

Picture

[TV / AV / Component / 
HDMI1 / HDMI2]

Mode MagicAngle Backlight Contrast Brightness

Sharpness Color Tint (G/R) Eco Solution Advanced Set-
tings

Picture Options Picture Reset

Sound Mode Equalizer Virtual Surround Dialog Clarity Preferred Lan-
guage

Multi-Track 
Sound

Auto Volume Speaker Select SPDIF Output Sound Reset

Channel Antenna Auto Program Clear Scram-
bled Channel

Channel List Fine Tune

Setup Plug & Play Time Menu Language Caption Security

General PIP

Input Source List Edit Name

Application Media Play Anynet+ (HDMI-
CEC)

Support Self Diagnosis Software 
Upgrade

HD Connection 
Guide

Contact Sam-
sung
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MENU DESCRIPTION

MagicBright <MagicBright> is a feature providing an optimum viewing environment depending on the contents of 
the image you are watching. Currently five different modes are available: <Entertain>, <Internet>, 
<Text>, <Dynamic Contrast> and <Custom>. Each mode has its own pre-configured brightness 
value. 
• <Entertain>

 High Brightness
 For watching motion pictures such as a Blu-ray or DVD.

• <Internet>
 For working with a mixture of images such as texts and graphics.

• <Text>
 For documents or work involving heavy text.

• <Dynamic Contrast>
<Dynamic Contrast> automatically detects the distribution of the visual signal and adjusts to 
create an optimum contrast.

• <Custom>
Although the values are carefully chosen by our engineers, the pre-configured values may not be 
comfortable to your eyes depending on your taste.
If this is the case, adjust the <Brightness> and <Contrast> by using the OSD menu.

MagicAngle This feature allows you to see optimal screen quality according to your viewing position.
When viewing the screen at an angle from below, above or the side of the product, by setting the 
appropriate mode for each position you can obtain a similar picture quality as viewing the screen 
directly from the front.
 Set to <Off> when viewing directly in front of the screen.

 

• <Off>  - Select when viewing from the front position.

• <Lean Back Mode1>  - Select when viewing from a slightly lower position.

• <Lean Back Mode2>  - Select when viewing from the lower position.

• <Standing Mode>  - Select when viewing from the upper position.

• <Side Mode >  - Select when viewing from the left or right position.

 Press the [TOOLS] button to display the Tools menu. You can also set the <MagicAngle> by 
selecting <Tools> → <MagicAngle>.

Contrast / Brightness / 
Sharpness 

You can use the on-screen menus to change the contrast and brightness according to personal pref-
erence.

• <Contrast> - Adjust the Contrast.

• <Brightness> - Adjust the Brightness.

• <Sharpness> - Adjust the Sharpness.
 

This menu is unavailable when <MagicBright> is set to <Dynamic Contrast> mode.
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Eco Solution • <No Signal Power Off>
Saves power by turning the TV off when no signal is received from any source.

• <Off> - <15 min.> - <30 min.> - <60 min.>
 

Disabled when the PC is on DPM(Display Power Management).
 

Auto Adjustment The values of <Fine>, <Coarse> and <Position> are adjusted automatically.

By changing the resolution in the control panel, auto function is performed.
 

Available only <PC> mode.
 

 Press the [TOOLS] button to display the Tools menu. You can also set the <Auto Adjustment> by 
selecting <Tools> → <Auto Adjustment>.

Screen • <Coarse>
Removes noise such as vertical stripes.
<Coarse> adjustment may move the screen image area. You may relocate it to the center using 
the horizontal control menu.

• <Fine>
Removes noise such as horizontal stripes.
If the noise persists even after <Fine> tuning, repeat it after adjusting the frequency <Coarse>.

• <Position>
Adjusts the screen location horizontally and vertically.

• <Image Reset>
Image parameters are replaced with the factory default values.

 

Available only <PC> mode.
 

Picture Options • <Color Tone>
The tone of the color can be changed.

• <Cool> - <Normal> - <Warm> - <Custom>
 

• Available only <PC> mode.

• Not available when <MagicBright> is <Dynamic Contrast>.
 

• <R-Gain > - < G-Gain > - <B-Gain >
Adjusts the individual R, G, B (Red, Green, Blue) color controls.
 

Not available when <MagicBright> is <Dynamic Contrast>.
 

• <Size>
 You can switch the Size.

• <16:9> - <4:3>

• <Auto Protection Time>
Set the time the screen remains idle with a still image until the screen saver is activated. The 
screen saver prevents the formation of ghost images on the screen.

• <2 hours> - <4 hours> - <8 hours> - <10 hours> - <Off>

Picture Reset Picture parameters are replaced with the factory default values.

• <OK> - <Cancel>

MENU DESCRIPTION
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Picture [ TV / AV / Component / HDMI1 / HDMI2 ] 

MENU DESCRIPTION

Mode You can select the type of picture which best corresponds to your viewing requirements.

You can activate either <Dynamic>, <Standard>, or <Movie>.

• <Dynamic>
Selects the picture for high-definition in a bright room.

• <Standard>
Selects the picture for optimum display in a normal environment.

• <Movie>
Selects the picture for viewing movies in a dark room.

MagicAngle This feature allows you to see optimal screen quality according to your viewing position.

When viewing the screen at an angle from below, above or the side of the product, by setting the 
appropriate mode for each position you can obtain a similar picture quality as viewing the screen 
directly from the front.
 

• Set to <Off> when viewing directly in front of the screen.

• The <TV>, <Component>, <AV> and <HDMI> modes only support the <Lean Back Mode1> 
and <Lean Back Mode2> menus.

 

• <Off>  - Select when viewing from the front position.

• <Lean Back Mode1>  - Select when viewing from a slightly lower position.

• <Lean Back Mode2>  - Select when viewing from the lower position.

• <Standing Mode>  - Select when viewing from the upper position.

• <Side Mode>  - Select when viewing from the left or right position.

 Press the [TOOLS] button to display the Tools menu. You can also set the <MagicAngle> by 
selecting <Tools> → <MagicAngle>.
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Backlight / Contrast / 
Brightness / Sharp-
ness / Color / Tint (G/
R)

Your product has several setting options that allow you to control the picture quality. 

• <Backlight > - Adjusts the brightness of LED back light.

• <Contrast> - Adjusts the contrast level of the picture.

• <Brightness> - Adjusts the brightness level of the picture.

• <Sharpness> - Adjusts the edge definition of the picture.

• <Color> - Adjusts color saturation of the picture.

• <Tint (G/R)> - Adjusts the color tint of the picture.
 

It is activated when the signal is NTSC.
 

Eco Solution You can choose various options of <Energy Saving> features. 

• <Energy Saving>
 You can reduce the power consumption by adjusting the screen brightness.

• <Off> - <Low> - <Medium> - <High> - <Picture Off> - <Auto>
 

• If you select <Picture Off>, the screen is turned off, but the sound remains on. Press any 
button except volume button to turn on the screen.

• Not available in PC/HDMI PC timing.
 

• <No Signal Power Off>
Saves power by turning the TV off when no signal is received from any source.

• <Off> - <15 min.> - <30 min.> - <60 min.>
 

Disabled when the PC is on DPM(Display Power Management).
 

Advanced Settings Samsung‘s new products allow you to make even more precise picture settings than previous mod-
els. See below to adjust detailed picture settings.
 

<Advanced Settings> is available in <Standard> or <Movie> mode.
 

• <Black Tone> - You can select the level on the screen to adjust the screen depth.

• <Off> - <Dark> - <Darker> - <Darkest>

• <Dynamic Contrast>  - You can adjust the screen contrast so that the optimal contrast is provided.

• <Off> - <Low> - <Medium> - <High>

• <Shadow Detail>  - Adjusts the dark level of screen.

• <Gamma> - You can adjust the Primary Color (Red, Green, Blue) Intensity.

• <RGB Only Mode> - Displays the red, green, or blue color for making fine adjustments to hue and 
saturation. 

• <Off> - <Red> - <Green> - <Blue>

• <Color Space> -  <Color Space> is a color matrix composed of red, green and blue colors. Select 
your favorite <Color Space> to experience the most natural color. 

• <Auto> - <Native>

• <White Balance> - You can adjust the color temperature for more natural picture colors.

• <R-Offset> - <G-Offset> - <B-Offset> - <R-Gain> - <G-Gain> -<B-Gain> - <Reset>

• <Flesh Tone> - You can emphasize the pink <Flesh Tone> in the picture.
 

Changing the adjustment value will refresh the adjusted screen.
 

• <Edge Enhancement> - You can emphasize object boundaries in the picture.

• <Off> - <On>
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Picture Options • <Color Tone>

The tone of the color can be changed.

• <Cool> - <Normal> - <Warm1> - <Warm2>
 

• <Warm1> or <Warm2> will be deactivated when the picture mode is <Dynamic>.

• Settings can be adjusted and stored for each external device you have connected to an 
input of the TV.

 

• <Size>

 You can switch the Size.

• <16:9> - Sets the picture to 16:9 wide mode. 

• <Zoom1> - Magnifies the size of the picture on the screen. 

• <Zoom2> - Magnifies the size of the picture more than <Zoom1>. 

• <Wide Fit> - Enlarges the aspect ratio of the picture to fit the entire screen. 
 

Available with HD 1080i / 720p signals in <16:9> mode.
 

• <4:3> - Sets the picture to 4:3 normal mode. 

• <Screen Fit> - Use the function to see the original image with no cut-off with HDMI (720p/ 1080i 
/ 1080p) or Component (1080i / 1080p) or DTV (1080i) input signals. 

 

• After selecting <Zoom1>, <Zoom2> or <Wide Fit>: Press the ▲ or ▼ button to select 
<Position>, then press the [ ] button. Press the ▲ or ▼ button to move the picture up 
and down.

• <Reset> : Press the ◄ or ► button to select <Reset>, then press the [ ] button. You 
can initialize the setting.

• Settings can be adjusted and stored for each external device you have connected to an 
input of the TV.

• <TV>, <AV>, <Component> (480i,480p)

- <16:9>, <Zoom1>, <Zoom2>, <4:3>

• <DTV> (1080i), <Component> (1080i, 1080p) ,<HDMI>(720p,1080i,1080p)

- <16:9>, <Wide Fit>, <4:3>, <Screen Fit>
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Sound

• <Digital Noise Filter>

If the broadcast signal received by your TV is weak, you can activate the <Digital Noise Filter> 
feature to reduce any static and ghosting that may appear on the screen.
 

• When the signal is weak, try other options until the best picture is displayed.

• <Auto Visualization> : When changing analog channels, displays signal strength.

- Only available for analog channels.

- When bar is green, you are receiving the best possible signal.
 

• <Off> - <Low> - <Medium> - <High> - <Auto> - <Auto Visualization>

• <MPEG Noise Filter>

Reduces MPEG noise to provide improved picture quality.

• <Off> - <Low> - <Medium> - <High> - <Auto>

• <HDMI Black Level>

Selects the black level on the screen to adjust the screen depth.

• <Normal> - <Low> 
 

Available only in <HDMI> mode.

 

• <Film Mode>

The <Film Mode> feature offers you a theater-quality viewing experience. 

• <Off> - <Auto1> - <Auto2> 
 

<Film Mode> is supported in <TV>, <AV>, <Component> (480i / 1080i) and <HDMI>(480i / 
1080i)

 

• <Auto Protection Time>

Set the time the screen remains idle with a still image until the screen saver is activated. The 
screen saver prevents the formation of ghost images on the screen. 

• <2 hours> - <4 hours> - <8 hours> - <10 hours> - <Off> 

Picture Reset Resets your current picture mode to its default settings.

• <OK> - <Cancel>
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MENU DESCRIPTION

Mode • <Standard>
 Choose Standard for the standard factory settings.

• <Music>
 Choose Music when watching music videos or concerts.

• <Movie>
 Choose Movie when viewing movies.

• <Clear Voice>
 Emphasizes voice over other sounds.

• <Amplify>
Increase the intensity of high-frequency sound to allow a better listening experience for the hearing 
impaired.

 Press the [TOOLS] button to display the Tools menu. You can also set the <Sound Mode> by 
selecting <Tools> → <Sound Mode>.

Equalizer You can adjust the left and right sound balance and equalizer settings as required.

• <Balance L/R> 
You can adjust the left and right sound balance and equalizer settings as required. 

• <100Hz> - <300Hz> - <1kHz> - <3kHz> - <10kHz> 
To adjust the level of different bandwidth frequencies. 

• <Reset> 
Resets the equalizer settings to the default values. 

 

<Standard> sound mode only
 

Virtual Surround This function provides a virtual 5.1 channel surround sound experience through a pair of speakers 
using HRTF (Head Related Transfer Function) technology.

• <Off> - <On>
 

<Standard> sound mode only
 

Dialog Clarity This function allows you to increase the intensity of a voice over background music or sound effects 
so that dialog can be heard more clearly.

• <Off> - <On>
 

<Standard> sound mode only
 

Preferred Language Digital-TV broadcasts are capable of simultaneous transmission of many audio tracks (for example, 
simultaneous translations of the program into foreign languages).

• <English> - <Spanish> - <French>
 

• Digital channels only

• You can listen in a language other than the Preferred Language by pressing the [MTS] 
button on the remote control.

• You can only select the language from among the actual languages being broadcast.
 

Using the Product 3-4



Multi-Track Sound • <Mono>
Choose for channels that are broadcasting in mono or if you are having difficulty receiving a stereo 
signal.

• <Stereo>
Choose for channels that are broadcasting in stereo.

• <SAP>
Choose to listen to the Separate Audio Program, which is usually a foreign-language translation.

 

• Available only Analog <TV> mode.

• Depending on the particular program being broadcast, you can listen to <Mono>, <Stereo> 
or <SAP>. 

 

 Press the [TOOLS] button to display the Tools menu. You can also set the <Multi-Track Sound> 
by selecting <Tools> → <Multi-Track Sound>.

Auto Volume To equalize the volume level on each channel, set to <Normal>.

• <Off> - <Normal> - <Night>
 

<Night> : This mode provides an improved sound experience compared to <Normal> mode, 
making almost no noise. It is useful at night.

 

Speaker Select When you watch product with it connecting to a Home theater, turn the product speakers off so you 
can listen to sound from the Home theater’s (external) speakers.

• <External Speaker>
Used to listen to the sound of the External (Home Theater) Speakers.

• <TV Speaker>
Used to listen to the sound of the product Speakers.

 

• If you select <External Speaker> in the <Speaker Select> menu, the sound settings will be 
limited.

• The volume and [MUTE] buttons do not operate when the <Speaker Select> is set to 
<External Speaker>. Please set the volume on your Home theater.

 

SPDIF Output SPDIF (Sony Philips Digital Interface) is used to provide digital sound, reducing interference going to 
speakers and various digital devices such as an A/V Receiver/Home theater.

• <Audio Format>
During the reception of a digital TV broadcast, you can select the Digital Audio output (SPDIF) 
format from the options <PCM> or <Dolby Digital>.

• <Audio Delay>
Correct audio-video sync problems, when watching TV or video, and when listening to digital 
audio output using an external device such as an AV receiver (0ms ~ 250ms).

Sound Reset Reset all sound settings to the factory defaults.

• <OK> - <Cancel>
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Channel

MENU DESCRIPTION

Antenna You can select antenna or cable TV.

If [ANT IN] connected, select the antenna input you want. If the antenna input is not selected prop-
erly, noise may appear on the screen.

• <Air> - <Cable>

Press the [TOOLS] button to display the Tools menu. You can also set the Air to (or Cable) 
<Antenna> by selecting <Tools> → <Switch to Air> (or <Switch to Cable>).

Auto Program The TV automatically cycles through all of the available channels and stores them in memory. 

In rare cases, <Auto Program> may miss a few channels due to weak signals and the channels may 
not be added to the channel memory.

• <Antenna Source> - Select the Antenna source to memorize.

• <Air> - <Cable> - <Auto>

• <Digital Cable System> - Select the digital cable system.

• <STD> - <HRC> - <IRC>

• <Analog Cable System> - Select the analog cable system.

• <STD> - <HRC> - <IRC>
 

• When selecting the Cable TV system: <STD>, <HRC> and <IRC> identify various types of 
cable TV systems. Contact your local cable company to identify the type of cable system 
that exists in your particular area. At this point, the signal source has been selected.

• After all the available channels are stored, it starts to remove scrambled channels. The 
<Auto Program> menu then reappears.

 

Clear Scrambled 
Channel

The <Clear Scrambled Channel> function is used to filter out scrambled channels after <Auto Pro-
gram> is completed. It removes the scrambled channels from the list by tuning the digital cable chan-
nels. 

This process may take up to 20~30 minutes. 
 

This function is only available in <Cable> mode.
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Channel List Using this menu, you can Add / Delete or set Favorite channels and use the program guide for digital 
broadcasts.

You can select these options by simply pressing the [CH LIST] button on the remote control.

• <All Channels> - Shows all currently available channels.

• <Added Channels> - Shows all added channels.

• <Favorite> - Shows all favorite channels.

 Press the [TOOLS] button to display the Tools menu. You can also set the add to (or delete 
from) <Favorite> by selecting <Tools> → <Add to Favorite> (or <Delete from Favorite>).
 

To select the favorite channels you have set up, press the [FAV.CH] button on the remote 
control.

 

• <Programmed> - Shows all current reserved programs.
 

• Select a channel in the <All Channels>, <Added Channels> or <Favorite> screen by 
pressing the ▲ / ▼ buttons, and pressing the [ ] button. Then you can watch the 
selected channel.

 

Using the Color buttons with the <Channel List>.

•  <Antenna> : Switches to <Air> or <Cable>.

•  <Zoom> : Enlarges or shrinks a channel number.

•  <Select> : Selects multiple channel lists. You can perform the <Add> / <Delete>, <Add to 
Favorite> / <Delete from Favorite> or <Select All> - <Deselect All> function for multiple 
channels at the same time. Select the required channels and press the yellow button to set all 
the selected channels at the same time. The check mark appears to the left of the selected 
channels.

•  <Page>: Move to next or previous page.

•  <Tools> : Displays the <Channel List> option menu. (The Options menus may differ 
depending on the situation.)

 

Channel Status Display Icons

• : A channel set as a Favorite.

• : A channel selected by pressing the yellow button.

• : A reserved program.

• : A program currently being broadcast.
 

Fine Tune Use fine tuning to manually adjust a particular channel for optimal reception.
 

• If you do not store the fine-tuned channel in memory, adjustments are not saved.

• Fine tuned channels that have been saved are marked with an asterisk ‘*’ on the right-hand 
side of the channel number in the channel banner.

• To reset the fine tuning setting, press the ▼ button to select <Reset>, then press the [ ] 
button.

• Only Analog TV channels can be fine tuned.
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Setup

MENU DESCRIPTION

Plug & Play This brings up the menu items that appeared when you first plugged in the TV.

Time • <Clock>
Setting the clock is necessary in order to use the various timer features of the TV.

• <Clock Mode>
 You can set up the current time manually or automatically.

• <Auto> - <Manual>
 

• Depending on the broadcast station and signal, the auto time may not be set 
correctly. If this occurs, set the time manually.

• The Antenna or cable must be connected in order to set the time automatically.
 

• <Clock Set>
 You can set the current time manually.

 

• This function is only available when <Clock Mode> is set to <Manual>.

• You can set the <Month>, <Day>, <Year>, <Hour> and <Minute> directly by pressing 
the number buttons on the remote control.

 

 

• The current time will appear every time you press the [INFO] button. 

• If you disconnect the power cord, you have to set the clock again. 
 

• <DST> (Daylight Saving Time)
 Switches the Daylight Saving Time function on or off.

• <Off> - <On>
 

This function is only available when <Clock Mode> is set to <Auto>.
 

• <Time Zone>
 Select your time zone.

 

This function is only available when <Clock Mode> is set to <Auto>.
 

• <Sleep Timer>
The sleep timer automatically shuts off the TV after a preset time.

• <Off> - <30 min.> - <60 min.> - <90 min.> - <120 min.> - <150 min.> - <180 min.>

 Press the [TOOLS] button to display the <Tools> menu. You can also set the <Sleep Timer> 
by selecting <Tools> → <Sleep Timer>.

 

To cancel the <Sleep Timer> function, select <Off>.
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• <Timer1 / Timer2 / Timer3>
Three different on / off timer settings can be made. You must set the clock first.

• <On Time>
Set the <Hour>, <Minute>, <am/pm>, and <Activate/Inactivate>.
(To activate the timer with the setting you’ve chosen, set to Activate.)

• <Off Time>
Set the <Hour>, <Minute>, <am/pm>, and <Activate/Inactivate>.
(To activate the timer with the setting you’ve chosen, set to Activate.)

• <Volume>
Set the desired volume level.

• <Source>
You can select the source to be played when the TV turns on automatically.
(<USB> can be selected only when a USB device is connected to the TV)

• <Antenna> (when the <Source> is set to <TV>)
View antenna type. <Air> or <Cable>.
 

You can set the <Antenna> by selecting <Channel> → <Antenna>.
 

• <Channel> (when the <Source> is set to <TV>)
Select the desired channel.

• <Contents> (when the <Source> is set to <USB>)
Select a folder in the USB device containing music or photo files to be played when the TV is 
turned on automatically.
 

• If there is no music file on the USB device or the folder containing a music file is not 
selected, the Timer function does not operate correctly.

• When there is only one photo file in the USB, the Slide Show will not play.

• If a folder name is too long, the folder cannot be selected.

• Each USB you use is assigned its own folder. When using more than one of the same 
type of USB, make sure the folders assigned to each USB have different names.

 

• <Repeat>
Select <Once>, <Everyday>, <Mon~Fri>, <Mon~Sat>, <Sat~Sun> or <Manual>.
 

• When <Manual> is selected, press the ► button to select the desired day of the 
week. Press the [ ] button over the desired day and the ( ) mark will appear.

• You can set the <Hour>, <Minute> and channel by pressing the number buttons on 
the remote control.

• Auto Power Off

When you set the timer On, the television will eventually turn off if no controls are 
operated for 3 hours after the TV was turned on by the timer. This function is only 
available in timer On mode and prevents overheating, which may occur if a TV is on 
for too long time.

 

Menu Language The language chosen affects only the language of the OSD. 
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Caption • <Caption>
You can switch the caption function on or off. If captions are not available, they will not be 
displayed on the screen.

• <Off> - <On>
 

• Press the [CC] turn the Caption on or off.

• The <Caption> feature doesn’t work in <Component>, <HDMI> or <PC> modes.
 

• <Caption Mode>
You can select the desired caption mode.
 

• The availability of captions depends on the program being broadcast.

• <Default> -<CC1>~<CC4> -<Text1>~<Text4> (Analog channels only)
The Analog Caption function operates in either analog TV channel mode or when a 
signal is supplied from an external device to TV. (Depending on the broadcasting 
signal, the Analog Caption function may operate on digital channels.)

• <Default> -<CC1>~<CC4> -<Text1>~<Text4> - <Service1> - <Service6> (Digital 
channels only)
The Digital Captions function operates on digital channels.

• <Service1~6> in digital caption mode may not be available depending on the broadcast.
 

• <Digital Caption Options> (Digital channels only)

• <Size> - <Font Style> - <Foreground Color> - <Background Color> - <Foreground Opacity> - 
<Background Opacity> - <Return to Default>

 

• The <Digital Caption Options> are only enabled when the <Caption Mode> is <Service1> 
~ <Service6>.
(If <Caption Mode> is the default, the <Digital Caption Options> are enabled depending 
on the broadcast.)

• The availability of captions depends on the program being broadcast.

• <Default> means to follow the standard set by the broadcaster.

• Foreground and Background cannot be set to have the same color.

• <Foreground Opacity> and <Background Opacity> cannot be both set to Transparent.
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Security The PIN input screen appears, Enter your 4 digit PIN number. 

• <V-Chip>
The <V-Chip> feature automatically locks out programs that are deemed inappropriate for 
children. The user must enter a PIN (personal ID number) before any of the <V-Chip> restrictions 
are set up or changed.
 

• <V-Chip> function is not available in <HDMI>, <Component> or <PC> mode.

• The default PIN number of a new TV set is 0-0-0-0.

• If you forget the PIN, press the remote-control buttons in the following sequence, which 
resets the pin to 0-0-0-0 : [POWER] (off)→[MUTE]→8→2→4→[POWER] (on).

• <Allow all>: Press to unlock all TV ratings.

• <Block all>: Press to lock all TV ratings.
 

• <V-Chip Lock> - You can block rated TV Programs.

• <Off> - <On>

• <TV Parental Guidelines> - You can block TV programs depending on their rating. This 
function allows you to control what your children are watching.

• <TV-Y>: Young children / <TV-Y7>: Children 7 and over / <TV-G>: General audience / 
<TV-PG>: Parental guidance / <TV-14>: Viewers 14 and over / <TV-MA>: Mature 
audience

• <ALL>: Lock all TV ratings. / <FV>: Fantasy violence / <V>: Violence / <S>: Sexual 
situation / <L>: Adult Language / <D>: Sexually Suggestive Dialog

 

The <V-Chip> will automatically block certain categories dealing with more sensitive 
material. For example, if you block the <TV-Y> category, then <TV-Y7> will 
automatically be blocked. Similarly, if you block the <TV-G> category, then all the 
categories in the young adult group will be blocked (<TV-G>, <TV-PG>, <TV-14> and 
<TV-MA>). The sub-ratings (<D>, <L>, <S>, <V>) work similarly. So, if you block the 
<L> sub-rating in <TV-PG>, then the <L> sub-ratings in <TV-14> and <TV-MA> will 
automatically be blocked.

 

• <MPAA Rating> - You can block movies depending on their <MPAA rating>. The Motion 
Picture Association of America(MPAA) has implemented a rating system that provides parents 
or guardians with information on which films are appropriate for children.

• <G>: General audience (no restrictions). / <PG>: Parental guidance suggested. / <PG-
13>: Parents strongly cautioned. / <R>: Restricted. Children under 17 should be 
accompanied by an adult. / <NC-17>: No children under age 17. / <X>: Adults only. / 
<NR>: Not rated.

 

The <V-Chip> will automatically block any category that deals with more sensitive 
material. For example, if you block the <PG-13> category, then <R>, <NC-17> and <X> 
will automatically be blocked.
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• <Canadian English> - You can block TV programs depending on their Canadian English rating.

• <C>: Programming intended for children under age 8. / <C8+>: Programming generally 
considered acceptable for children 8 years and over to watch on their own. / <G>: General 
programming, suitable for all audiences. / <PG>: Parental Guidance. / <14+>: 
Programming contains themes or content which may not be suitable for viewers under the 
age of 14. / <18+>: Adult programming.

 

The <V-Chip> will automatically block any category that deals with more sensitive 
material. For example, if you block the <G> category, then <PG>, <14+> and <18+> will 
automatically be blocked.

 

• <Canadian French> - You can block TV programs depending on their French Canadian rating.

• <G>: General / <8 ans+>: Programming generally considered acceptable for children 8 
years and over to watch on their own. / <13 ans+>: Programming may not be suitable for 
children under the age of 13. / <16 ans+>: Programming is not suitable for children under 
the age of 16. / <18 ans+>: Programming restricted to adults.

 

The <V-Chip> will automatically block any category that deals with more sensitive 
material. For example, if you block the <8 ans+> category, then <13 ans+>, <16 ans+> 
and <18 ans+> will automatically be blocked also.

 

• <Downloadable U.S. Rating> - Parental restriction information can be used while watching 
DTV channels.
 

• If information is not downloaded from the broadcasting station, the <Downloadable 
U.S. Rating> menu is deactivated.

• Parental restriction information is automatically downloaded while watching DTV 
channels. It may take several seconds.

• The <Downloadable U.S. Rating> menu is available for use after information is 
downloaded from the broadcasting station. However, depending on the information 
from the broadcasting station, it may not be available for use.

• Parental restriction levels differ depending on the broadcasting station. The default 
menu name and <Downloadable U.S. Rating> change depending on the downloaded 
information.

• Even if you set the on-screen display to another language, the <Downloadable U.S. 
Rating> menu will appear in English only.

• The rating will automatically block certain categories that deal with more sensitive 
material.

• The rating titles (For example: Humor Level..etc) and TV ratings (For example: DH, 
MH, H..etc) may differ depending on the broadcasting station.

 

• <Change PIN>
The <Change PIN> screen will appear. Choose any 4 digits for your PIN and enter them.
You can change your personal ID number that is required to set up the TV.
As soon as the 4 digits are entered, the <Confirm New PIN> screen appears. Re enter the same 4 
digits. When the Confirm screen disappears, your PIN has been memorized.

How to watch a restricted channel
- If the TV is tuned to a restricted channel, the V-Chip will block it. The screen will go blank and the 
following message will appear:
- This channel is blocked by V-Chip. Please enter the PIN to unblock.
 

If you forget the PIN, press the remote-control buttons in the following sequence, which 
resets the pin to “0-0-0-0” : [POWER] (off) → [MUTE] → 8 → 2 → 4 → [POWER] (on).
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General • <Max. Power Saving> - Conserve power by turning the monitor off when the PC is not used for a 
specified period.

• <Off> - <On>
 

Available only <PC> mode.
 

• <Game Mode> - When connecting to a game console such as PlayStation™ or Xbox™, you can 
enjoy a more realistic gaming experience by selecting game menu.

• <Off> - <On>
 

• Restrictions on game mode (Caution)

• To disconnect the game console and connect another external device, set <Game 
Mode> to <Off> in the setup menu. If you display the TV menu in <Game mode>, the 
screen shakes slightly.

• If <Game Mode> is <On> :

• <Picture> mode is automatically changed to <Standard> and cannot be changed.

• <Sound> mode is automatically changed to <Movie> and cannot be changed. Adjust 
the sound using the <Equalizer>.

• <Game Mode> is not available in regular <TV> and <PC> mode.

• If the picture is poor when external device is connected to TV, check if <Game Mode> is 
<On>. Set <Game Mode> to <Off> and connect external devices.

 

• <Menu Transparency> - Set the Transparency of the menu.

• <Bright> - <Dark>

• <Melody> - A melody sound can be set to come on when the monitor is powered On or Off. 

• <Off> - <Low> - <Medium> - <High>
 

The <Melody> does not play

• When no sound is output from the TV because the [MUTE] button has been pressed.

• When no sound is output from the TV because the volume has been reduced to 
minimum with the volume [-] button.

• When the TV is turned off by <Sleep Timer> function.
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PIP You can use the PIP feature to simultaneously watch the TV tuner and one extemal video source. 
This product has one built-in tuner, which does not allow PIP to function in the same mode.

 Press the [TOOLS] button to display the <Tools> menu. You can also set the <PIP> by selecting 
<Tools> → <PIP>.
 

PIP Settings.

 

 

• If you turn the TV off while watching in PIP mode and turn it on again, the PIP window will 
disappear.

• You may notice that the picture in the PIP window becomes slightly unnatural when you use 
the main screen to view a game or karaoke.

 

• <PIP>
You can activate or deactivate the PIP function. 

• <On> - <Off>

• <Air/Cable>
Selects either Air or Cable as the input source for the sub-screen.

• <Channel>
Selects the channel for the sub-screen. 
 

<Channel> is available when the <Source> is set to <TV>.
 

• <Size>→  / 
You can select a size of the sub-picture.

• <Position>→  /  /  / 
You can select a position of the PIP-picture.

• <Sound Select>
You can choose the desired sound (<Main> / <Sub>) in <PIP> mode. 

• <Main> - <Sub>

MENU DESCRIPTION

Main picture

PC, Component, HDMI1, HDMI2

Sub picture

TV
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Input

MENU DESCRIPTION

Source List Use to select <PC>, <TV> or an external input source connected to the product. Use to select the 
screen of your choice.

You can use the [SOURCE] button on the remote control.

• <PC> / <TV> / <AV> / <Component> / <HDMI1> / <HDMI2> / <USB>
 

• <AV> and <Component> cannot be connected at the same time.

• In the <Source List>, connected inputs will be highlighted.

• <PC> and <TV> always stay activated
 

Edit Name Name the input device connected to the input jacks to make your input source selection easier.

• <VCR> - <DVD> - <Cable STB> - <Satellite STB> - <PVR STB> - <AV Receiver> - <Game> -
<Camcorder> - <PC> - <DVI PC> - <DVI Devices> - <TV> - <IPTV> - <Blu-ray> - <HD DVD> - 
<DMA>

 

When a PC with a resolution of 1920 x 1080@60Hz is connected to the [HDMI (DVI) IN] port, 
you should set the <HDMI> mode to <DVI PC> in the <Edit Name> of the <Input> mode. In this 
case, a separate sound connection is required.
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Application

Support

MENU DESCRIPTION

Media Play Enjoy photos, music and/or movie files saved on a USB Mass Storage Class (MSC) device.
 

See "3-5. Media Play" for details.
 

Anynet+ (HDMI-CEC) What is <Anynet+>?

<Anynet+> is a function that enables you to control all connected Samsung devices that 
support <Anynet+> with your Samsung TV‘s remote. The <Anynet+> system can be used only 
with Samsung devices that have the <Anynet+> feature. To be sure your Samsung device 
has this feature, check if there is an <Anynet+> logo on it.
 

See "3-6. Anynet+ (HDMI-CEC)" for details.
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MENU DESCRIPTION

Self Diagnosis  • <Picture Test>

If you think you have a picture problem, perform the picture test. Check the color pattern on the 
screen to see if the problem still exists.

• <Yes> : If the test pattern does not appear or there is noise in the test pattern, select <Yes>. 
There may be a problem with the TV. Contact Samsung‘s call center for assistance.

• <No> : If the test pattern is properly displayed, select <No>. There may be a problem with your 
external equipment. Please check your connections. If the problem still persists, refer to the 
external device‘s user manual.

• <Sound Test>

If you think you have a sound problem, please perform the sound test. You can check the sound by 
playing a built-in melody sound through the TV. 

• <Yes> : If during the sound test you can hear sound only from one speaker or not at all, select 
<Yes>. There may be a problem with the TV. Contact Samsung’s call center for assistance.

• <No> : If you can hear sound from the speakers, select <No>. There may be a problem with 
your external equipment. Please check your connections. If the problem still persists, refer to 
the external device’s user manual.

 

• If you hear no sound from the TV‘s speakers, before performing the sound test, make 
sure <Speaker Select > is set to <TV Speaker> in the <Sound> menu.

• The melody will be heard during the test even if <Speaker Select> is set to <External 
Speaker> or the sound is muted by pressing the [MUTE] button.

 

• <Signal Information>(Digital channels only)

Unlike analog channels, which can vary in reception quality from snowy to clear, digital (HDTV) 
channels have either perfect reception quality or you will not receive them at all. So, unlike analog 
channels, you cannot fine tune a digital channel. You can, however, adjust your antenna to 
improve the reception of available digital channels. 
 

If the signal strength meter indicates that the signal is weak, physically adjust your antenna to 
increase the signal strength. Continue to adjust the antenna until you find the best position 
with the strongest signal. 

 

• <Troubleshooting>

<Troubleshooting>: If the TV seems to have a problem, refer to this description.
 

If none of these troubleshooting tips apply, contact the Samsung customer service center.

 

Software Upgrade • <By USB>

Insert a USB drive containing the firmware upgrade downloaded from samsung.com into the TV. 
Please be careful to not disconnect the power or remove the USB drive while upgrades are being 
applied. The TV will turn off and turn on automatically after completing the firmware upgrade. 
Please check the firmware version after the upgrades are complete (the new version will have a 
higher number than the older version).

When software is upgraded, video and audio settings you have made will return to their default 
(factory) settings. We recommend you write down your settings so that you can easily reset them 
after the upgrade.

• <Alternative Software> (Not available)

HD Connection Guide This menu presents the connection method that provides the optimal quality for the HDTV. Refer to 
this information when connecting external devices to the TV.

Contact Samsung View this information when your TV does not work properly or when you want to upgrade the soft-
ware. You can view the information regarding the call center, product and software file download 
method.
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3-5 Media Play

Connecting a USB Device

1. Turn on your TV.

2. Connect a USB device containing photo, music and/or movie files to the [USB] jack on the back of the TV.

3. When USB is connected to the TV, a popup window appears. Then you can select <Media Play>.
 

It might not work properly with unlicenced multimedia files.
 

 

Need-to-Know List before using <Media Play> 

• MTP (Media Transfer Protocol) is not supported.

• The file system supports FAT16, FAT32 and NTFS.

• Certain types of USB Digital camera and audio devices may not be compatible with this TV.

• <Media Play> only supports USB Mass Storage Class (MSC) devices. MSC is a Mass Storage Class Bulk-Only 
Transport device. Examples of MSC are Thumb drives and Flash Card Readers. Devices should be connected directly 
to the TV’s USB port. USB is not supported.

• Before connecting your device to the TV, please back up your files to prevent them from damage or loss of data. 

Enjoy photos, music and/or movie files saved on a USB Mass Storage Class (MSC) device and/or your pc.
Using the Product 3-5



SAMSUNG is not responsible for any data file damage or data loss.

• Do not disconnect the USB device while it is loading.

• The higher the resolution of the image, the longer it takes to display on the screen.

• The maximum supported JPEG resolution is 15360X8640 pixels.

• For unsupported or corrupted files, the “Not Supported File Format” message is displayed.

• If the files are sorted by Basic View, up to 1000 files can be displayed in each folder.

• MP3 files with DRM that have been downloaded from a non-free site cannot be played. Digital Rights 
Management(DRM) is a technology that supports the creation, distribution and management of the content in an 
integrated and comprehensive way, including the protection of the rights and interests of the content providers, the 
prevention of the illegal copying of contents, as well as managing billings and settlements.

• If more than 2 PTP devices are connected, you can only use one at a time.

• If more than two MSC devices are connected, some of them may not be recognized. A USB device that requires high 
power (more than 500mA or 5V) may not be supported.

• If an over-power warning message is displayed while you are connecting or using a USB device, the device may not be 
recognized or may malfunction.

• If the TV has been no input during time set in <Auto Protection Time>, the Screensaver will run.

• The power-saving mode of some external hard disk drives may be released automatically when connected to the TV.

• If a USB extension cable is used, the USB device may not be recognized or the files on the device may not be read.

• If a USB device connected to the TV is not recognized, the list of files on the device is corrupted or a file in the list is not 
played, connect the USB device to the PC, format the device and check the connection.

• If a file deleted from the PC is still found when <Media Play> is run, use the “Empty the Recycle Bin” function on the PC 
to permanently delete the file.

 

Screen Display

Move to the file you desired using the up/down/right/left buttons and then press the [ ] or [ ] (Play) button.  
The file is played.
 

Supports the <View Devices> and <Home> in <Media Play> homepage.
 

 

NUMBER MENU DESCRIPTION

Information You can ascertain the selected file name and the number of files and page.

Sort List Section Displays sorting standard.
 

Sorting standard is different depending on the contents.
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Videos

Playing Video

 

1. Press the  or  button to select <Videos>, then press the [ ] button in the <Media Play> menu.

2. Press the  button to select the desired video in the file list.

3. Press the [ ] button or [ ] (Play) button.

• The selected file is displayed on the top with its playing time.

• If video time information is unknown, play time and progress bar are not displayed.

• During playing the video, you can search using the  and  button.
 

In this mode, you can enjoy movie clips contained on a Game, but you cannot play the Game itself.
 

• Supported Subtitle Formats

Operation Buttons
•  Red (Change Device)

Selects a connected device.

•  Green (Preference)
Sets the file preference. (not supported in Basic view)

•  Yellow (Select)
Selects multiple files from file list. Selected files are marked with a symbol.

•  Blue (Sorting)
Selects the sort list.

•  (Tools)
Displays the option menu.

 

Using the [ ] (REW) or [ ] (FF) button, file list can move to next or 
previous page.

 

File List Section You can confirm the files and groups that is sorted by each category.

NAME FILE EXTENSION FORMAT

MPEG-4 time-based text .ttxt XML

SAMI .smi HTML

SubRip .srt string-based

NUMBER MENU DESCRIPTION
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• Supported Video Formats

SubViewer .sub string-based

Micro DVD .sub or .txt string-based

FILE 
EXTENSION CONTAINER VIDEO CODEC RESOLUTION

FRAME 
RATE
(FPS)

BIT RATE
(MBPS)

AUDIO CODEC

*.avi

*.mkv

AVI

MKV

Divx 3.11 /

4.x / 5.1 / 6.0
1920 x 1080 6 ~ 30 8

MP3

AC3

LPCM 

ADPCM

DTS Core

XviD 1920 x 1080 6 ~ 30 8

H.264 BP /

MP / HP
1920 x 1080 6 ~ 30 25

MPEG4 SP /

ASP
1920 x 1080 6 ~ 30 8

*.asf ASF

Divx 3.11 /

4.x / 5.1 / 6.0
1920 x 1080 6 ~ 30 8

MP3

AC3

LPCM

ADPCM

WMA

XviD 1920 x 1080 6 ~ 30 8

H.264 BP /

MP / HP
1920 x 1080 6 ~ 30 25

MPEG4 SP /

ASP
1920 x 1080 6 ~ 30 8

*.wmv ASF
Window Media 

Video v9
1920 x 1080 6 ~ 30 25 WMA

*.mp4 MP4

H.264 BP /

MP / HP
1920 x 1080 6 ~ 30 25

MP3

ADPCM

AAC

MPEG4 SP /

ASP
1920 x 1080 6 ~ 30 8

XVID 1920 x 1080 6 ~ 30 8

*.3gp 3GPP

H.264 BP / 

MP / HP
1920 x 1080 6 ~ 30 25 ADPCM

AAC

HE-AAC
MPEG4 SP / 

ASP
1920 x 1080 6 ~ 30 8

*.vro
VRO

VOB

MPEG1 1920 x 1080 24 / 25 / 30 30 AC3

MPEG

LPCM
MPEG2 1920 x 1080 24 / 25 / 30 30

*.mpg

*.mpeg
PS

MPEG1 1920 x 1080 24 / 25 / 30 30 AC3

MPEG

LPCM

AAC

MPEG2 1920 x 1080 24 / 25 / 30 30

H.264 1920 x 1080 6 ~ 30 25

NAME FILE EXTENSION FORMAT
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Other Restrictions
 

• If there are problems with the contents of a codec, the codec will not be supported.

• If the information for a Container is incorrect and the file is in error, the Container will not be able to play correctly.

• Sound or video may not work if the contents have a standard bitrate/frame rate above the compatible Frame/sec 
listed in the table above.If the information for a Container is incorrect and the file is in error, the Container will not be 
able to play correctly.

 

Playing movie file continuously (Resume Play)
If you exit the playing videos function, it can be played later from the point where it was stopped.

 

1. Select the movie file you want to play continuously by pressing the  or  button to select it from the file list section.

2. Press the [ ] (Play) / [ ] button.

3. Select <Play Continuously> (Resume Play) by pressing the Blue button. The Movie will begin to play from where it was 
stopped.

 

• The Blue button is available when resuming play.

• If the <Continuous Movie Play Help> function is set to <On> in the <Settings> menu, a pop-up message will appear 
when you resume play a movie file.

 

*.ts

*.tp

*.trp

TS

MPEG2 1920 x 1080 24 / 25 / 30 30 AC3 

AAC 

MP3

DD+

HE-AAC

H.264 1920 x 1080 6 ~ 30 25

VC1 1920 x 1080 6 ~ 30 25

VIDEO DECODER AUDIO DECODER

• Supports up to H.264, Level 4.1

• H.264 FMO / ASO / RS, VC1 SP / MP / AP L4 and 
AVCHD are not supported.

• GMC is not supported.

• H.263 is not supported.

• Supports up to WMA 7, 8, 9, STD

• WMA 9 PRO does not support 2 channel excess multi 
channel or lossless audio.

• WMA sampling rate 22050Hz mono is not supported.

FILE 
EXTENSION CONTAINER VIDEO CODEC RESOLUTION

FRAME 
RATE
(FPS)

BIT RATE
(MBPS)

AUDIO CODEC
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Music

Playing Music

 

1. Press the  or  button to select <Music>, then press the [ ] button in the <Media Play> menu.

2. Press the  button to select the desired file in the file list.

3. Press the [ ] button or [ ] (Play) button.

• During playing the music, you can search using the  and  button.

• [ ] (REW) and [ ] (FF) buttons do not function during play.
 

• Only displays the files with MP3 and PCM file extension. Other file extensions are not displayed, even if they are 
saved on the same USB device.

• If the sound is abnormal when playing MP3 files, adjust the <Equalizer> in the <Sound> menu. (An over-modulated 
MP3 file may cause a sound problem.)

 

Photos

Viewing a Photo (or Slide Show)

 

1. Press the  or  button to select <Photos>, then press the [ ] button in the <Media Play> menu.

2. Press the  button to select the desired photo in the file list.

3. Press the [ ] button or [ ] (Play) button.

• While a photo list is displayed, press the [ ] (Play) / [ ] button on the remote control to start the slide show.

• All files in the file list section will be displayed in the slide show.

• During the slide show, files are displayed in order.
 

• Music files can be automatically played during the Slide Show if the <Background Music> is set to <On>.
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• The <BGM Mode> cannot be changed until the BGM has finished loading.
 

Playing the Multiple Files

Playing the selected video/music/photo files

 

1. Press the Yellow button in the file list to select the desired file.

2. Repeat the above operation to select multiple files.
 

• The  mark appears to the left of the selected files.

• To cancel a selection, press the Yellow button again.

• To deselect all selected files, press the [TOOLS] button and select <Deselect All>.
 

3. Press the TOOLS button and select <Play Selected Contents>.

Playing the video/music/photo file group
1. While a file list is displayed, move to the any file in desired group.

2. Press the TOOLS button and select <Play Current Group>.

Media Play Additional Function

Sorting the file list
Press the Blue button in the file list to sort the files.

CATEGORY OPERATIONS VIDEOS MUSIC PHOTOS

Basic View It shows whole folder. You can view the photo by select-
ing the folder.

Title It sorts and displays the file title in Symbol / Number / 
Alphabet / Special order.

Preference It sorts and displays the file by preference. You can 
change the file preference in the file list section using 
the Green button.

Latest Date It sorts and shows files by latest date.
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Videos / Music / Photos Play Option menu
During playing a file, press the [TOOLS] button.

Earliest Date It sorts and shows files by earliest date.

Artist It sorts the music file by artist in alphabetical.

Album It sorts the music file by album in alphabetical order.

Genre It sorts music files by the genre.

Mood It sorts music files by the mood. You can change the 
music mood information. 

Monthly It sorts and shows photo files by month. It sorts only by 
month (from January to December) regardless of year.

CATEGORY OPERATIONS VIDEOS MUSIC PHOTOS

Title You can move the other file directly.

Repeat Mode You can play movie and music files repeatedly.

Picture Size You can adjust the picture size for preference.

Picture Setting You can adjust the picture setting.

Sound Setting You can adjust the sound setting.

Subtitle Setting You can play the video file with Subtitle. This function 
only works if the subtitles are the same file name as the 
video file.

Audio You can enjoy video in one of supported languages as 
required. The function is only enabled when stream-type 
files which support multiple audio formats are played.

Stop Slide Show /  
Start Slide Show

You can start or stop a slide show.

Slide Show Speed You can select the slide show speed during the slide 
show.

Background Music You can set and select background music when watch-
ing a slide show.

Zoom You can zoom into images in full screen mode.

Rotate You can rotate images in full screen mode.

Information You can see detailed information about the played file.

CATEGORY OPERATIONS VIDEOS MUSIC PHOTOS
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Settings

Using the Settings Menu

MENU DESCRIPTION

Continuous Movie 
Play Help

Select to display the help pop-up message for continuous movie playback.

• <On> - <Off>

Get DivX® VOD regis-
tration code

Shows the registration code authorized for the TV. If you connect to the DivX web site and register 
the registration code with a personal account, you can download VOD registration file. If you play 
the VOD registration using <Media Play>, the registration is completed.
 

For more information on DivX® VOD, visit "www.DivX.com."
 

Get DivX® VOD deac-
tivation code

When DivX® VOD is not registered, the registration deactivation code is displayed. If you execute 
this function when DivX® VOD is registered, the current DivX® VOD registration is deactivated.

Information Select to view information about the connected device.
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3-6 Anynet+ (HDMI-CEC)

What is Anynet+?
<Anynet+> is a function that enables you to control all connected Samsung devices that support <Anynet+> with your Samsung 
TV‘s remote. The <Anynet+> system can be used only with Samsung devices that have the <Anynet+> feature. To be sure your 
Samsung device has this feature, check if there is an <Anynet+> logo on it.

Connecting Anynet+ Devices

1. Connect the [HDMI (DVI) IN 1, 2] jack on the TV and the HDMI OUT jack of the corresponding <Anynet+> device using an 
HDMI cable.

2. Connect the [HDMI IN] jack of the home theater and the HDMI OUT jack of the corresponding <Anynet+> device using an 
HDMI cable. 
 

• Connect the Optical cable between the [DIGITAL AUDIO OUT (OPTICAL)] jack on your TV and the Digital Audio 
Input on the Home Theater. 

• When following the connection above, the Optical jack only outputs 2 channel audio. You will only hear sound from 
the Home Theater‘s Front Left and Right speakers and the subwoofer. If you want to hear 5.1 channel audio, 
connect the [DIGITAL AUDIO OUT (OPTICAL)] jack on the DVD / Satellite Box ( i.e. Anynet Device 1 or 2) directly 
to the Amplifier or Home Theater, not the TV.

• You can connect only one Home Theater.

• You can connect an <Anynet+> device using the HDMI cable. Some HDMI cables may not support <Anynet+> 
functions.

• <Anynet+> works when the AV device supporting <Anynet+> is in the Standby or On status.

• <Anynet+> supports up to 10 AV devices in total. Note that you can connect up to 3 devices of the same type.
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<Anynet+> Menu
The <Anynet+> menu changes depending on the type and status of the Anynet+ devices connected to the TV.

If more than one recording device is connected, they are displayed as (*recorder) and if only one recording device is 
connected, it will be represented as (*device_name).

Setting Up Anynet+

 Press the [TOOLS] button to display the Tools menu. You can also display the <Anynet+> menu by selecting <Tools> → 
<Anynet+ (HDMI-CEC)>.

<ANYNET+> MENU DESCRIPTION

View TV Changes <Anynet+> mode to TV broadcast mode.

Device List Shows the Anynet+ device list.

Recording: (*recorder) Starts recording immediately using the recorder. 

(This is only available for devices that support the recording function.)

(device_name) MENU Shows the connected device menus. E.g. If a DVD recorder is connected, the disc menu of 
the DVD recorder will appear.

(device_name) INFO Shows the play menu of the connected device. E.g. 

If a DVD recorder is connected, the play menu of the DVD recorder will appear.

Stop Recording: (*recorder) Stops recording.

Receiver Sound is played through the receiver.
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MENU DESCRIPTION

Device List 1. Press the [TOOLS] button. Press the [ ] button to select <Anynet+ (HDMI-CEC)>.

2. Press the  or  button to select <Device List>, then press the [ ] button.

 - <Anynet+> devices connected to the TV are listed.

 - If you cannot find a device you want, press the red button to scan for devices.

3. Press the  or  button to select a particular device and press the [ ] button. It is switched to the 
selected device. 

 - <Anynet+ (HDMI-CEC)> must be set to <On> in the <Application> menu for the <Device List> 
menu to appear.
 

Switching to the selected devices may take up to 2 minutes. You cannot cancel the operation 
during the switching operation. 

The time required to scan for devices is determined by the number of connected devices. 

When the device scan is complete, the number of devices found are not displayed. 

Although the TV automatically searches the device list when the TV is turned on via the power 
button, devices connected to the TV may not always be automatically displayed in the device 
list. Press the red button to search for the connected device. 

If you have selected external input mode by pressing the [SOURCE] button, you cannot use the 
<Anynet+> function. Make sure to switch to an <Anynet+> device by using the <Device List>. 

 

Setup • <Anynet+ (HDMI-CEC)>
To use the <Anynet+> Function, <Anynet+ (HDMI-CEC)> must be set to <On>. 
 

When the <Anynet+ (HDMI-CEC)>function is disabled, all the <Anynet+> related operations 
are deactivated. 

 

• <Auto Turn Off>
Setting an <Anynet+> Device to turn Off automatically when the TV is turned off.
 

The active source on the TV remote must be set to TV to use the <Anynet+> function. 

If you set <Auto Turn Off> to <Yes>, connected external devices are also turned off when the 
TV is turned off. If an external device is still recording, it may or may not turn off. 
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3-7 Installing the Device Driver

 

If you install the device driver, you can set up the appropriate resolution and frequency for the product. The device driver is 
included on the CD supplied with the product. If the supplied drive file is corrupted, please visit the Samsung Electronics 
website (www.samsung.com), and download the driver.

 

1. Insert the driver installation CD into the CD-ROM drive.

2. Click on Windows Driver.

3. Complete the remaining installation steps according to the instructions displayed on the screen.

4. Select the model of your product from the model list.

5. Check if the appropriate resolution and screen refresh rate are displayed in the Control Panel settings. For more information, 
refer to the document about the Windows operating system.
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3-8 Standard Signal Mode Table

 

This product delivers the best picture quality when viewed under the optimal resolution setting. The optimal resolution 
setting is dependent on the screen size.

Therefore, the visual quality will be degraded if the optimal resolution is not set for the panel size. It is recommended setting 
the resolution to the optimal resolution of the product.

 

PC Timing (PC and HDMI input)

If the signal from the PC is one of the following standard signal modes, the screen is set automatically. However, if the signal from 
the PC is not one of the following signal modes, a blank screen may be displayed or only the Power LED may be turned on. 
Therefore, configure it as follows referring to the User Manual of the graphics card.

Horizontal Frequency

The time taken to scan one line from the left-most position to the right-most position on the screen is called the horizontal cycle 
and the reciprocal of the horizontal cycle is called the horizontal frequency. The horizontal frequency is represented in kHz.

Vertical Frequency

A panel must display the same picture on the screen tens of times every second so that humans can see the picture. This 
frequency is called the vertical frequency. The vertical frequency is represented in Hz.

RESOLUTION
HORIZONTAL 
FREQUENCY 

(KHZ)

VERTICAL 
FREQUENCY  

(HZ)

CLOCK 
FREQUENCY

(MHZ)
POLARITY (H/V)

IBM, 640 x 350 31.469 70.086 25.175 +/-

IBM, 640 x 480 31.469 59.940 25.175 -/-

IBM, 720 x 400 31.469 70.087 28.322 -/+

MAC, 640 x 480 35.000 66.667 30.240 -/-

MAC, 832 x 624 49.726 74.551 57.284 -/-

MAC, 1152 x 870 68.681 75.062 100.000 -/-

VESA, 640 x 480 37.861 72.809 31.500 -/-

VESA, 640 x 480 37.500 75.000 31.500 -/-

VESA, 800 x 600 35.156 56.250 36.000 +/+

VESA, 800 x 600 37.879 60.317 40.000 +/+

VESA, 800 x 600 48.077 72.188 50.000 +/+

VESA, 800 x 600 46.875 75.000 49.500 +/+

VESA, 1024 x 768 48.363 60.004 65.000 -/-

VESA, 1024 x 768 56.476 70.069 75.000 -/-

VESA, 1024 x 768 60.023 75.029 78.750 +/+

VESA, 1152 x 864 67.500 75.000 108.000 +/+

VESA, 1280 X 800 49.702 59.810 83.500 -/+

VESA, 1280 X 960 60.000 60.000 108.000 +/+

VESA, 1280 X 1024 63.981 60.020 108.000 +/+

VESA, 1280 X 1024 79.976 75.025 135.000 +/+

VESA, 1440 x 900 55.935 59.887 106.500 -/+

VESA, 1680 x 1050 65.290 59.954 146.250 -/+

VESA, 1920 x 1080 67.500 60.000 148.500 +/+
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4 Installing the Software

4-1 Natural Color

What is Natural Color ?

This software is for Samsung products only and enables you to adjust the displayed colors on the product so they more closely 
match the colors of printed pictures. For more information, refer to the online help of the software (F1).

Natural Color is provided online. You can download it from the website below and install;

http://www.samsung.com/us/consumer/learningresources/monitor/naturalcolorexpert/pop_download.html
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4-2 MultiScreen

What is MultiScreen ?

MultiScreen enables you to partition multiple sections on the product.

Installing the Software
1. Insert the installation CD into the CD-ROM drive. 

2. Select the MultiScreen setup program.
 

If the pop-up screen for the software installation does not appear on the main screen, find and double-click the 
MultiScreen setup file on the CD-ROM.

 

3. When the Installation Wizard appears, click [Next].

4. Complete the remaining software installation steps according to the instructions displayed on the screen.
 

• The software may not work properly if you do not restart the computer after the installation.

• The MultiScreen icon may not appear depending on the computer system and the product specifications.

• If the shortcut icon does not appear, press the F5 key.
 

MultiScreen Installation Requirements
The MultiScreen installation may be affected by the graphics card, motherboard and the networking environment. 

Operating System

OS
• Windows 2000

• Windows XP Home Edition

• Windows XP Professional

• Windows Vista 32Bit

• Windows 7 32Bit
 

For MultiScreen, Windows 2000 or later operating systems are recommended. 
 

Hardware
•  At least 32MB of memory

•  At least 60MB of free space on the hard disk drive 

Removing the Software 
Click [Start], select [Settings]/[Control Panel], and then double-click [Add or Remove Programs]. 

Select MultiScreen from the program list and click the [Add/Delete] button. 
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5 Troubleshooting

5-1 Product Self-Diagnosis

 

• You can check if the product is working properly using the Self-Diagnosis function.

• If a blank screen is displayed and the Power LED blinks even if the product and the PC are properly connected, perform 
the self-diagnosis function according to the procedures below.

 

1. Turn the product and the PC off.

2. Remove the D-Sub cable from the product. 

3. Turn the product on. 

4. If the product is working properly, the <Check Signal Cable.> message appears.
In this case, if a blank screen is displayed again, make sure that there is no problem with the PC and the connection.
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5-2 Before Requesting Service

 

Please check the following before requesting After-Sales service. If the problem continues, please contact your nearest 
Samsung Electronics Service Center.

 

PROBLEMS RELATED TO INSTALLATION (PC MODE)

The monitor screen flickers. Check if the signal cable between the computer and the monitor is securely 
connected and tightened.

(Refer to Connecting to a Computer) 

Blank spaces are found at the top and bottom of 
the screen when an HDMI or HDMI-DVI cable is 
connected to the monitor and PC.

Blank spaces on the screen are not caused by the monitor.

The cause of the problem is the PC or graphics card, and can be fixed by 
adjusting the screen size in the HDMI or DVI option of the graphics card 
settings menu.

If the graphics card settings menu has no option to adjust the screen size, 
update the graphics card driver to the latest version.

(Please contact the graphics card or computer manufacturer for details on 
how to adjust the screen settings.)

PROBLEMS RELATED TO SCREEN

Screen is blank and power indicator is off. Ensure that the power cord is firmly connected and the product is on.

(Refer to Connecting to a Computer) 

<Check Signal Cable> message Ensure that the signal cable is firmly connected to the PC or video sources.

(Refer to Connecting to a Computer) 

<Mode not supported> message Check the maximum resolution and the frequency of the video adapter.

Compare these values with the data in the Standard Signal Mode Table. 

Picture rolls vertically. Check if the signal cable is securely connected.Connect it again securely. 

(Refer to Connecting to a Computer) 

Image is not clear. Picture is blurred. Run Frequency <Coarse> and <Fine> tuning.

Turn on again after removing all accessories(video extension cable, etc.)

Set resolution and frequency to the recommended ranges.

Picture image is unstable and vibrates. Check if the resolution and frequency set for the computer video card falls 
in the range supported by the monitor. If not, reset them referring to the 
current <Information> under the monitor menu and Standard Signal Mode 
Table.

Ghost images are shown in the picture.

The image is too light or too dark Adjust the <Brightness> and <Contrast>.

(Refer to the <Brightness>, <Contrast>) 

The display brightness can differ according to the mode set for <MagicAn-
gle>. 

If <MagicBright> is set to <Dynamic Contrast>, the display brightness can 
differ according to the input signal. 

Screen is blank and the power indicator light 
blinks every 0.5 or 1 seconds

The monitor is using its power management system.

Press a key on the keyboard.

The screen is blank and is blinking. If you see the <TEST GOOD> message on the screen when you press the 
[MENU] button, check the cable connection between the monitor and the 
computer to ensure that the connector is properly connected.
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PROBLEMS RELATED TO AUDIO

No sound Ensure that the audio cable is firmly connected to both the audio-in port on 
your monitor and the audio-out port on your sound card.

(Refer to Connecting to a Computer) 

Check the volume level.

The sound level is too low. Check the volume level.

If the volume is still too low after turning the control to its maximum, check 
the volume control on the computer sound card or software program.

PROBLEMS RELATED TO REMOTE CONTROL 

The remote control buttons do not respond. Check the battery polarities (+/-).

Check if the batteries have been exhausted.

Check if the power is on.

Check if the power cord is securely connected.

Check if a special fluorescent or neon lamp is on in the vicinity.

NOTE ON THE PRODUCT APPEARANCE

You may see small particles if you look closely at 
the edge of the bezel surrounding the screen.

This is part of the product's design and is not a defect.
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5-3 FAQ

FAQ PLEASE TRY THE FOLLOWING!

How can I change the frequency of the video sig-
nal?

You have to change the frequency of the graphics card.

Windows XP : Change the frequency by selecting Control Panel → 
Appearance and Themes → Display → Settings → Advanced → Moni-
tor, and then change the refresh rate under Monitor Settings. 

Windows ME/2000 : Change the frequency by selecting Control Panel  → 
Display  → Settings → Advanced → Monitor, and then change the 
refresh rate under Monitor Settings.

Windows Vista : Change the frequency by selecting Control Panel → 

Appearance and Personalization → Personalization → Display settings → 
Advanced settings → Monitor, and then change the refresh rate under 
Monitor Settings. 

Windows 7 : Change the frequency by selecting Control Panel → Appear-
ance and Personalization → Display → Adjust resolution → Advanced 
settings → Monitor, and then change the refresh rate under Monitor Set-
tings. 

(For more information, refer to the User Manual of the computer or the 
graphics card.)

How can I change the resolution? Windows XP : Change the resolution by selecting Control Panel → 
Appearance and Themes → Display → Settings. 

Windows ME/2000 : Change the resolution by selecting Control Panel → 
Display → Settings. 

Windows Vista : Change the resolution by selecting Control Panel → 
Appearance and Personalization → Personalization → Display settings.

Windows 7 : Change the resolution by selecting Control Panel → Appear-
ance and Personalization → Display → Adjust resolution.

(For more information, refer to the User Manual of the computer or the 
graphics card.)

How can I use the power saving function? Windows XP : Configure it by selecting Control Panel → Appearance and 
Themes → Display → Screen Saver Setting or configure it in the BIOS 
Setup of the computer.

Windows ME/2000 : Configure it by selecting Control Panel → Display → 
Screen Saver Setting or Configure it in the BIOS Setup of the computer. 

Windows Vista : Change settings by selecting Control Panel → Appear-
ance and Personalization → Personalization → Screen Saver. You can 
also use the BIOS SETUP menu on the PC.

Windows 7 : Change settings by selecting Control Panel → Appearance 
and Personalization → Personalization → Screen Saver. You can also use 
the BIOS SETUP menu on the PC.

(For more information, refer to the Windows user manual for the com-
puter.)

How can I clean the outer case Panel? Disconnect the power cord and then clean the monitor with a soft cloth, 
using either a plain water.

Do not leave any detergent or scratches on the case.

Do not let any water enter the monitor.
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Can I watch digital TV broadcasting with an ana-
log TV?

No.

The analog TV cannot interpret digital signals. Therefore, a digital TV is 
required to watch digital TV broadcasting.

Can I use my present antenna to receive digital 
broadcasting?

As for existing analog TV, digital TV is designed so that digital broadcast-
ing signals are received via both indoor and outdoor antennas.

If signal reception is very good in your environment, you can watch digital 
broadcasts with your existing indoor antenna. If not, it is better to install an 
outdoor antenna.

FAQ PLEASE TRY THE FOLLOWING!
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6 More Information

6-1 Specifications

 

Design and specifications are subject to change without prior notice. 
 

 

Class B (Information Communication Equipment for Home Use) 

This device is registered for EMC requirements for home use (Class B). It can be used in all areas. (Class B equipment 
emits less electromagnetic waves than Class A equipment.)

 

MODEL NAME FX2490HD

Panel Size 24 inches (61 cm)

Display area 531.36 mm (H) X 298.89 mm (V) (20.9 inches X 11.8 inches)

Pixel Pitch 0.27675 mm (H) X 0.27675 mm (V) (0.010896 inches X 0.010896 
inches)

Synchronization Horizontal 30~81 kHz

Vertical 56~75 Hz

Color 16.7M

Resolution Optimum resolution 1920x1080 @ 60 Hz

Maximum resolution 1920x1080 @ 60 Hz 

Input Signal, Terminated Analog(D-Sub port), Digital DVI(HDMI port) 0.7 Vp-p ± 5 %
Separate Type H/V Sync, Composite TTL Level (V high ≥ 2.0 V, V 
low ≤ 0.8 V)

Maximum Pixel Clock 148.500 MHz (Analog, Digital)

Power Supply This product supports 100 – 240 V. Since the standard voltage 
may differ from country to country, please check the label on the 
back of the product.
(DC 14V  4.5A)

Dimensions (WxHxD) / Weight (Simple stand) 579.0 x 363.0 x 36.5 mm (22.8 x 14.3 x 1.4 inches) (Without 
Stand)

579.0 x 436.0 x 216.0 mm (22.8 x 17.2 x 8.5 inches) (With Stand) 
/ 5.3 kg (11.7 Ibs)

Environmental considerations Operating Temperature : 50°F ~ 104°F (10°C ~ 40°C)

Humidity : 10 % ~ 80 %, non-condensing

Storage Temperature : -4°F ~ 113°F (-20°C ~ 45°C)

Humidity : 5 % ~ 95 %, non-condensing

Tilt -1˚ ~ 21˚ (±1˚)
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6-2 Power Saving Function

This product provides a power saving function that automatically turns the screen off when the product is not used for a 
predetermined period of time to reduce power consumption. If the product enters power saving mode, the power LED turns to a 
different color to indicate that the product is in power saving mode. 

When the product is in power saving mode, the power is not turned off and you can turn the screen on again by pressing any key 
or clicking the mouse. However, the power saving function only works when the product is connected to a computer that provides 
the power saving function.

 

• The actual power consumption may be different from the indicated power consumption above if the system conditions or 
settings are changed.

• If there is no power cut-off switch, the power consumption is "0" only when the power cord is disconnected.

• DPM(Display Power Management) Function does not work if you used in conjunction with the [HDMI] port of this 
product. 

 

POWER SAVING 
FUNCTION NORMAL OPERATION POWER SAVING 

MODE(DPM)
POWER OFF (POWER 

BUTTON)

Power LED On Blinks Off

Power Consumption 35 Watts Analog : less than 0.3 Watts less than 0.3 Watts
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6-3 Contact SAMSUNG WORLDWIDE

 

• If you have any questions or comments relating to Samsung products, please contact the SAMSUNG customer care 
center.

 

NORTH AMERICA

U.S.A 1-800-SAMSUNG(726-7864) http://www.samsung.com

CANADA 1-800-SAMSUNG(726-7864) http://www.samsung.com

MEXICO 01-800-SAMSUNG(726-7864) http://www.samsung.com

LATIN AMERICA

ARGENTINA 0800-333-3733 http://www.samsung.com

BRAZIL 0800-124-421

4004-0000

http://www.samsung.com

CHILE 800-SAMSUNG(726-7864) http://www.samsung.com

COLOMBIA 01-8000112112 http://www.samsung.com

COSTA RICA 0-800-507-7267 http://www.samsung.com

ECUADOR 1-800-10-7267 http://www.samsung.com

EL SALVADOR 800-6225 http://www.samsung.com

GUATEMALA 1-800-299-0013 http://www.samsung.com

HONDURAS 800-7919267 http://www.samsung.com

JAMAICA 1-800-234-7267 http://www.samsung.com

NICARAGUA 00-1800-5077267 http://www.samsung.com

PANAMA 800-7267 http://www.samsung.com

PUERTO RICO 1-800-682-3180 http://www.samsung.com

REP. DOMINICA 1-800-751-2676 http://www.samsung.com

TRINIDAD & TOBAGO 1-800-SAMSUNG(726-7864) http://www.samsung.com

VENEZUELA 0-800-100-5303 http://www.samsung.com
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